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Introduction 
 
In this tutorial we will go through the step of analyzing a dataset using many of 
MetaCore’s various tools; including maps, networks, pre-built networks, diseases, 
processes, etc.  The dataset we will be using is from a psoriasis study, which is publicly 
available (1).  
 
Background: Psoriasis is recognized as the most common T cell-mediated inflammatory 
disease in humans.  Genetic linkage to as many as six distinct disease loci has been 
established but the molecular etiology and genetics remain unknown. To begin to identify 
psoriasis disease-related genes and construct in vivo pathways of the implicated 
processes, genome-wide expression screens of psoriasis patients need to be undertaken. 
Disease-related gene maps may provide new insights into the pathogenesis of psoriasis. 
 
Methods: Four psoriasis patients’ skin biopsies were sampled at two different time 
points, at the time of developed psoriatic lesion and at the time of recession. The samples 
were taken from the same exact skin spot from each patient, after which Affymetrix 
Human U95A microarray technology was utilized to evaluate the expression data. In this 
tutorial we will use this data represented as fold changes for each gene between psoriasis 
and normal-like skin for each patient, with corresponding p-values. 
 
Objective: To apply whole-genome microarray data from Kulski et al (J Mol Med 2005) 
(1) to discover molecular pathways distinct for psoriasis, and to evaluate the molecular 
character of the disease using MetaCore™ functionality. 
 
Getting started 
 
This tutorial assumes that the data has already been uploaded to MetaCore.  For more 
information about uploading data, please see the “How to use the Data Manager” tutorial 
available in the Help section of MetaCore.  To begin analysis, first activate the data.  
When analyzing data make sure that the threshold is set appropriate to the data values in 
your file.  The Threshold works as an absolute value, so for example, if the Threshold is 
set to 3, any genes with data values less that 3 and greater than -3 will be filtered out.  
The P Threshold filters out any genes with a p-value greater than the entered P threshold.  
After setting the desired thresholds, click OK.  The effect of the thresholds can be seen in 
the Properties for the experiments and the experiments’ statistics.  To set the threshold 
select “Set threshold” from the Tools menu (Figure 1).  For this data we will set the 
Threshold (corresponding to our uploaded fold change values) to 2 and the P-value 
Threshold to 0.05. 
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Figure 1: 1. Experiment activated.  2. Click here to set the thresholds. 
 
Enrichment Analysis Workflow 
 
The best place to start analyzing multiple data files is to use the Enrichment Analysis 
Workflow tool.  In this case, we would like understand common functional themes in 
psoriasis pertaining to all samples. To compare the four samples and learn what is 
overrepresented among their common, similar, and unique genes, we select “Enrichment 
Analysis Workflow…” from the Tools menu.  The “Enrichment Analysis Workflow” can 
also be accessed from the “Analyze Data” section of the EZ Start interface (Figure 2). 
On the page that appears, you can modify the threshold settings (or set them if you have 
not done so yet), and also choose what signals to use (up-regulated=”+”, down-
regulated=”-“, or both).  After choosing the settings, click the Apply button (Figure 3). 
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Figure 2: 1. Go to the Analyze Data section.  2. Click here to access the Enrichment Analysis 
Workflow. 
 

  
Figure 3: 1. Set thresholds here.  2. Select the “Intersection between datasets” tab. 3. Click Apply to 
start the comparison. 
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Here, we may want to find out what are the functional profiles of up-regulated genes in 
the psoriasis set, so we choose the “up” Signals to filter and sort by.  
First, the intersections will be calculated.  The intersections tell you how many of the 
network objects in your experiments are common to all experiments, how many are 
unique, and how many are similar (neither common to all experiments nor unique).  One 
of the intersections calculated is the “best”, meaning that it contains the most common 
network objects.  Next the distributions are calculated.  The distributions are histograms 
showing the top 10 most significant results.  A p-Value is calculated for the common and 
unique groups.  The results are ranked by the –log(p-Value).  By default the most 
significant results for the common part is displayed.  Mouse over a bar to see the  
–log(p-Value) and the number of network objects in that group.  Clicking the bar will 
allow you to build a network around the intersection objects, or view the map image in 
the case of the Distribution by canonical pathway maps. In this distribution we see which 
multistep pathways from literature consensus are most significantly enriched in our data 
set. 
 
Top pathway maps suggest immune and inflammatory themes with possible involvement 
of IFNs-alpha/beta and STATs. This is an intuitively reasonable result for this disease, 
and it is most significant for common and similar genes (striped and clear bars). Map 
number 4 happens to be a custom map specific to this account, which was generated with 
use of an add-on module Map Editor. 
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Figure 4: 1. Intersections displayed here.  2. Click on a name to open a map. 
 
Now we will open the top significant map.  Click on the map name to open it (Figure 4).  
The map name will open in a new window and the data values will be automatically 
mapped on it.  Any data, which is placed into the Active Data window of the Data 
Manager will be automatically overlaid on any map or network that we open up. Data 
Values are represented by colored bars (thermometer-like icons) next to their associated 
genes. 
 
There are many other visualization options available on maps.  To access these, click the 
“Visualization Options” header.  By selecting an option from one of the Marker 
categories, the objects associated with the selected category will by marked by a flashing 
icon.  Here we will mark the objects related to the Psoriasis disease, the skin tissue, and 
all drug targets.   
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Figure 5: 1. Data visualized as thermometer icons.  2. Select visualization markers here.  3. Disease, 
tissue and drug target markers are next to their associated object. 
 
The map image itself is interactive.  You can click on the objects and interactions for 
more database information and literature references.  After clicking on an interaction 
hexagon a window appears containing links to the PubMed articles where the interaction 
information was found.  Additionally, from this window you can export selected 
references to EndNote, by clicking the red Export button. 
 
Clicking on the objects will take you to the object information page.  From here you can 
build a network around that object and you can go to the database page for the gene, 
protein, compound, and maps associated with the object. You can also see which GO 
processes and Diseases it is involved in, and see all other network objects that it interacts 
with, all summarized for up/downstream activation/inhibition, and mechanisms of 
interactions (including unspecified effects and mechanisms) with links to those objects 
and to the literature support behind each interaction info. 
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Figure 6: 1. Click on an interaction hexagon for PubMed links.  2.  Click on an object for more object 
information. 
 
Some of the flashing visualization markers are also clickable.  Clicking on one of the 
drug target icons (flashing R) will take you to the compound details page.  From here you 
can search the MDL DiscoveryGate software based on the compound.  To do so, select a 
search method and click the “Search in DiscoveryGate” button.  The DiscoveryGate 
software will then open and automatically perform the selected search. From the 
compound detail page you would also be able to build a network around it, or explore its 
other targets and learn how specific or broad the action of the compound may be. 
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Figure 7: 1. Access MDL DiscoveryGate by using this button. 
 
There are other export options available on the map page as well.  It is possible to export 
a list of genes on the map.  First click the “Export options” header.  Then enter a name 
for the list and click the Export button.  You can also export only those genes with 
experimental data by checking the box next to “With expression data only”.  Genes from 
the map can be exported to Rosetta Resolver, GeneSpring GX and Spotfire DecisionSite 
by selecting the desired tool in the “Export to” row. Exporting the  map image itself is 
also possible in 300 dpi publication-quality png format. 
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Figure 8: 1.Click here to access the export options.  2. Genes can be exported to third-party software 
here. 
 
GeneGo Content Networks 
 
Networks, such as those that depict proteins and interactions for different functional 
cellular processes, can also be accessed from the Enrichment Analysis Workflow results.  
MetaCore contains a number of pre-built networks.  These are based on processes, 
disease biomarkers, and metabolic pathways.  In the Distribution by GeneGo Processes, 
we see similar themes as were picked up by the canonical pathway maps ontology 
enrichment graph (except now among the top process we also see a proteolysis network).  
Click on a top process name to open the network (Figure 9). 
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Figure 9: 1. Click here to open a GeneGo Process network. 
 
Data values on networks are represented by red and blue circles.  You can click on the 
circle to see the specific values (Figure 10).  Networks are more interactive than maps; 
you can click and drag the objects to move them.  You can also click the objects and 
interaction beads/hexagons for more information, just as with maps.   
 

1
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Figure 10: 1. Data represented by red and blue circles. 
 
Sometimes networks can be more complex than maps.  When this occurs, there are many 
features of the network interface that can help make networks less complex and easier to 
view and interpret.  One such option is to hide the effect hexagons (that describe 
mechanisms of interactions).  To do this, uncheck the ‘Effects’ option in the Show menu. 
 
This will make edges appear as simple lines, but the overall effect information will be 
visible with green being activation, red – inhibition. Directionality of interactions is 
always available and will be easily traceable with arrows and with hover codes that 
enable your to mouse over any node and see all the up-stream interactions and nodes 
highlighted yellow, and downstream – light blue. 
Another option to ease network view and manageability is to hide objects that do not 
have data values.  To do this, open the Edit menu, then select the Selection sub-menu, 
and then click on the Hide non-expressed objects option.  The objects that do not have 
expression values (or basically ANY values that came from the active data sets and 
passed the applied threshold) will be hidden.  Hidden objects can be brought back by 
clicking the ‘Show all hidden objects’ button on the toolbar (Figure 11). 
 

1
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Figure 11: 1. Click here to hide the non-expressed objects.  2. Effect hexagon are not shown here. 
 
You could also use advanced selection options (explained more on p22) to choose 
specific classes of proteins (like trans-factors, receptors, ligands, etc…) and hide all 
unselected objects that you do not choose to focus on. 
 
Build Networks 
 
Networks can also be built ‘on the fly’ by starting with a list of objects from your data 
that you are interested in and using one of our network building algorithms to construct a 
network.  In some studies, such as comparisons between disease and normal, or between 
effects of one treatment agent vs. another, one may want to click on the thin unique bar(s) 
to build specific ‘signature networks’ for the unique genes for that set. Here, we want to 
focus on commonly up-regulated psoriasis genes, so we will click on the common group 
of objects from the Enrichment Analysis Workflow results.  This will bring up a new 
window containing the network building algorithms. 
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Figure 12: 1. Click here to build a network starting with the common objects. 
 
Network Options 
 
This page contains our network building algorithms.  Analyze network creates a large 
network and breaks it up into smaller sub-networks which can be built separately.  This 
algorithm is good for large sets of data.  The Shortest paths algorithm tries to link the 
original genes with additional objects from the database.  The Direct interactions 
algorithm creates a network only from the objects in the original list.  Auto expand adds 
objects until it creates a fairly dense network, this is best used to see the interactions 
around a few nodes.  Analyze transcription regulation works similar to analyze network, 
except the sub-networks created are centered on transcriptional factors.  The Self 
regulations algorithm is like shortest paths except it tries to connect nodes with 
transcription factors.  Finally, Expand by one interaction simply adds all the one-step 
interactions around each node from the list.   
 
Two additional “Analyze network” algorithms (transcription factors and receptors) are 
also available.  These options focus on the presence of either start-nodes or end-nodes of 
a certain pathway in the submitted list of genes. 

1
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The “transcription factors” mechanism favors network construction where the end-nodes 
/ receptor targets of transcriptionally regulated pathways are present in the original gene 
list.  It is irrelevant for this algorithm if the corresponding transcription factors are also 
present in the original gene list or not. 
 
The “receptors” mechanism favors network construction where the end-point of a 
pathway leads to a receptor (through “receptor binding”) and the starting point of a 
pathway (a transcription factor, or ligands, etc…) is present in the original gene list, 
regardless of the presence of the end-point receptor in the list.  
 
Another option available here is the ability to pre-filter a network based on tissue, sub-
cellular localization, organism, object type, and/or interaction type.  The resulting 
network then contains only those objects that are known to be expressed in the selected 
tissue, localization, and organism; or are of the selected object type(s) or connected by 
the selected interaction type(s).  To use the pre-filters, uncheck the ‘Disabled’ box and 
click the Select button to select the pre-filter criteria.  In this case, leave the pre-filters 
disabled. 
 
On the Network Options page, you can also choose to use canonical pathway 
interactions.  Checking the box to enable this feature will instruct the network building 
algorithms to try to use interactions that also appear on MetaCore’s canonical pathway 
maps.  Interactions added in this manor will be highlighted on the resulting network.  
 
Here we will use the Analyze network (transcription factors) algorithm (Figure 13). 
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Figure 13: 1. Select Analyze network (transcription factors) and then click Build network.  2. Pre-
filters are located here 
 
Network List 
 
All Analyze network algorithm sub-divide the resulting ‘master network’ with a large 
number of genes and return a list of generated sub-networks ranked by corresponding p-
values.  The table also lists the top five related GO processes for each network, the total 
number of objects in the network, the number of objects in the network from the original 
list (Target genes, also sometimes termed as “Root Nodes”), the number of canonical 
pathways implicated in each network, and a Z-Score.  You can click the Scoring 
Procedures button and the “?” button next to Priority options for more information about 
the p-Value and Z-Score calculations. More information and details on algorithms and 
scoring procedures can be found by clicking the Questions and Answers link on top of 
the Data Manager page. 
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Networks are also named on the fly based on the main elements involved in each (hubs, 
nodes, etc…).  By seeing the list of resulting networks, their main elements, and 
associated processes, one can get the idea of main resulting functional network themes 
before deciding which ones to open and explore.  
 
By un-checking all the boxes and selecting a couple of networks of interest, these 
networks can be merged by clicking “Merge Selected.” The entire network list can also 
be saved (click Save button on top right) to be able go back and open /merge any of the 
networks at any time in the future from this list. 
 
Click the link in the Network column to visualize networks one at a time (Figure 14). 
 

 
Figure 14: 1. Click here to view the network. 
 
Working with the Network 
 
There are many other tools that can be used on the network interface.  These include 
selecting specific types object for filtering/hiding, filtering experiments, viewing 
pathways, drug targets, processes, and diseases.  Just as with maps, you can export lists of 

1
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genes to MetaCore and to other third-party software.  You can also obtain statistics about 
the network in a tabular format and save the network to MetaCore or as an image file. 
 
Advanced Select Tool 
 
With this tool you can select specific object types.  After selecting them you can export 
the genes from the selected objects, or use the selection for filtering.  For example, to see 
what happens to the network when the transcription factors are removed, select 
‘Transcription factor’ from the list and click the Select button.  Then click the ‘Hide 
selected objects’ button on the toolbar.  All the transcription factors on the network will 
then be hidden. 
 

 
Figure 15: 1. Click here to open the Advanced Select tool.  2. Transcription factors selected. 
 
Filter Experimental Data 
 
It is also possible to filter experimental data and visually compare similarly or 
differentially regulated genes.  Click the Experiments tab; select the experiments to view; 
and click Apply.  Objects with experimental data only from the checked experiment(s) 
will display the blue and red circles next to them. If you un-check all experiments, the 
network will only contain objects themselves, but no data (Figure 16).  The Experiments 
filter also has the option to animate the data.  This will display the data circles for each 
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selected experiment individually and toggle through them. This provides a useful visual 
illustration of the differences and similarities in gene regulation on this network between 
different samples. If at this point we wanted to also overlay samples from another data set 
or simply change threshold settings to see which additional genes light up, we could 
activate or set thresholds for the data in Data Manager, and then get back to this network 
window and click the red button “Apply current Experiment Data” to visualize current 
sample or newly updated filtering conditions on the network. 
 

 
Figure 16: 1. Use the experiments tab to filter out experimental data.  2. Blue and red circles no 
longer appear.  3. Click here to cycle through the selected experiments. 
 
Trace Pathways on a Network 
 
If the “Use canonical pathways” option was checked on the Network Options page and 
canonical pathways are present on the network (turquoise colored interaction arrows), 
you can use the Pathways tab to automatically trace the individual canonical pathways 
present on the network.  The Pathways tab contains the list of all the canonical pathways 
on the network.  Click on a pathway to highlight its interactions in green.  Clicking the 
“Animate” button will cycle through all the pathways on the network.  You can also click 
the “View source” button to see the map or pre-built network that the selected pathway is 
from (Figure 17). 
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Figure 17: 1. Selected pathway is highlighted in green.  2. Click here to see the source map or pre-
built network. 
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Marking Drug Targets on a Network 
 
Press the Drug Targets button to mark the objects on the network that have drug targets.  
Objects with drug targets will be marked with a grey circle (Figure 18). 
 

 
Figure 18: 1. Click the Drug Targets button.  2. Objects with drug targets will be marked in grey. 
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The GO Processes Tab 
 
Click the GO Processes tab to see the top 12 functional processes associated with the 
network.  After clicking the GO Processes tab, a dialog box will appear asking if you 
wish to continue, click OK.  The coverage percentage and p-Value for each process are 
also listed.  You can select genes involved in (a) particular process(es) by clicking “mark 
selected”. Any time we make a selection we can choose to hide unselected objects and 
thereby focus on the portion of network dealing particularly with selected processes or 
diseases or drug targets or tissue, or orthologs. We could choose keratinocyte 
differentiation from the list here, because it is relevant to psoriasis and is also one of the 
top scoring processes, and then select all the corresponding genes, and hide unselected 
ones to filter out less relevant processes. 
 
We can also trace a process by selecting it and clicking the Trace Selected button.  The 
process will be traced automatically using the trace objects feature (Figure 19).  
 

 
Figure 19: 1. Check a process and click Trace Selected.  2. The process will be traced automatically. 
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The Diseases Tab 
 
Click the Diseases tab to see the top 12 diseases associated with the network.  This tool 
works similar to the Processes tab.  After clicking the Diseases tab, a dialog box will 
appear asking if you wish to continue, click OK.  The coverage percentage and p-Value 
for each disease are also listed.  You can trace a disease by selecting it and clicking the 
Trace Selected button.  The disease will be traced automatically using the trace objects 
feature (Figure 20). If we wanted to narrow down our network to specified disease genes, 
we would use the Mark Selected option and then hide all unselected nodes. Here, for 
instance, we could concentrate only on skin diseases by selecting the genes in the top 
significant disease category and hiding all un-selected nodes. 
 

 
Figure 20: 1. Check a disease and click Trace Selected.  2. The disease will be traced automatically. 
 
Exporting a List of Genes from a Network 
 
As with maps, it is possible to export a list of genes from a network.  Here, we will export 
a list of genes from a selected disease.  First, open the diseases tab and select a disease.  
Then, click Mark Selected.  In the export section (above the network), choose Genes in 
the ‘Export as’ row, check the ‘Advanced mode’ box and choose Selected nodes next to 
‘Which nodes’.  Finally, give the list a name and click the Export button (Figure 21).  In 
addition to exporting to MetaCore, you can export genes to Rosetta Resolver, GeneSpring 
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GX, Spotfire DecisionSite, and to Excel. Excel table output with default options will 
include all network genes. Those network genes that have data values mapped onto them 
will be have those sample ID’s and values exported in the table and marked with different 
shades of red and blue, according to the sign and magnitude of values in those cells. 
 

 
Figure 21: 1. Choose a disease and click Mark Selected.  2. Choose Genes.  3. Export selected nodes.  
4. Enter a name and click Export. 
 
Network Statistics 
 
Various statistics about a network can be seen by clicking the Network Statistics button 
or by choosing Network Statistics from the File menu. This allows you to see a tabular 
overview of the network including information about how the network was built; any 
experimental data on the network; how active different objects are in the network; and the 
GO processes, diseases and tissues related to the network (Figure 22).   
 
The top section of the statistics page displays basic information about the network 
including its name and description (a description can be added by clicking the "Rename" 
button on the network page). Click on a section hyperlink to go directly to that section or 
click a section header to open the information panel. The first section shows what options 
were used when building the network including the algorithm used, any chosen pre-filters 
and the advanced options used.  All the nodes with experimental data are listed as well. 
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The table includes the network object, its related genes, the gene description, and the data 
value (Figure 23). All of the objects on the network are listed in the Hubs and Nodes 
sections. A Hub is a node that has five or more edges on the network.  Two numbers are 
listed in the edges column. The first number is the total number of edges for that node 
and the second number is the number of hidden edges for that node on the network. An 
edge is hidden if one or more of the nodes connected to it is hidden or if the nodes 
connected by the edge are in a group. 
 

 
Figure 22: 1. Click a link to jump to that section. 
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Figure 23: 1. Click the headers to open each section. 2. The Experiments section lists the objects with 
data. A description of the object and the data value are listed as well. 
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Figure 24: 1. Visible edges / Hidden edges are listed for each Node and Hub. 2. Click the “Edges” 
header to sort the table. 
 
Saving Networks and Images 
 
Networks can be saved in two formats, Networks and Netshots.  Netshots retain the 
network exactly as it is with any expression data mapped.  Saved Networks, however, do 
not retain the expression data and will reflect any subsequent changes to the objects or 
interactions on the network as the MetaCore database is updated.  So, if you save a 
network as both a Network and a Netshot you can see exactly how it looked when it was 
created (with the Netshot) and how it may have changed with subsequent MetaCore 
updates (with the Network).  To save a network, choose “Save” or “Save as” from the 
File menu.  Then, in the window that appears, enter a name and optional description; 
choose whether to save it as a Network or a Netshot; and then click “Save”.  From this 
window you can also choose to retain or discard any hidden objects by checking or 
unchecking the “Save hidden nodes and edges” box (Figure 25). 
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Figure 25: 1.  Click here to save the network. 2. Choose Network or Netshot here. 3. Enter a name 
and optional description. 4. Choose to save or discard hidden objects here. 
 
High quality images (300dpi) of networks can be saved as well.  To save an image of a 
network choose the “Export image” option from the file menu.  In the box that appears, 
choose a resolution and click OK (Figure 26).  Then browse for a location on your 
computer to save the file.  The image file type is PNG. 
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Figure 26: 1. Click here to export an image file. 2. Choose a resolution and click OK. 
 
Data Sharing 
 
With the Data Manager, you can share experiments, gene lists, and saved networks with 
other users or groups. There are two ways to access the share tool. You can either click 
Share from the File menu after selecting an experiment by Left-Clicking on it, or you can 
Right-Click on an experiment and select Share in the context menu.  The window that 
comes up will display some information about the experiment and a field to search for 
users to share it with. Enter a username in the search field and click Search. Select a user 
in the results field and click “Add selected to list”. The user will appear in the “Shared 
with” section (Figure 27). 
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There are six share levels available. The most permissive level is on the left and the least 
permissive level is on the right. The different levels are: 
 

Allow 
- OW - Owner Rights. This level will allow the user it is shared with to 

share it to others and to delete it. 
- WA - Write Access. This level will allow the user it is shared with to 

rename it and to overwrite it. 
- RA - Read Access. This level will only allow the user it is shared with 

to view the experiment(s) and related maps, networks, etc. 
Deny 

- OW - Owner Rights. Choose this level if you have, for example, 
allowed ownership rights to an entire folder, but would like to deny 
ownership right to some individual experiments within the shared 
folder. 

- WA - Write Access. Choose this level to deny write access to 
individual experiments with a shared folder. 

- RA - Read Access. Choose this level to totally restrict all access to a 
file within a shared folder. 

 
Additionally, if you wish to completely give up your ownership of a file to another user, 
first select to Allow Owner Rights (OW) of the file to the other user and then check the 
box next to "Refuse from ownership" and click OK. You will then no longer have 
ownership rights to the file. 
 
Experiments you own that are shared with other users will be marked with a blue hand 
icon in the Data Manager ( ). Experiments owned by another user that are shared with 
you, can be found in the Shared Data folder and they will be marked with a green hand 
icon ( ). 
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Figure 27: 1. Search for the user to share with here. 2. Select a user and click “Add  
selected to list”. 3. Set the sharing level and click OK. 
 
Results 
 
This network alone shows the activation and interplay of two key processes in psoriasis. 
Key regulators that are overexpressed have major implications in immune-system-
regulated inflammation /response to stimuli, and keratinocyte differentiation 
/proliferative processes, as can be also inferred from the canonical pathway edges 
associated with them (thick turquoise lines).  A few significantly overexpressed genes, 
such as S100A7 and Calgranulin-B (S100A9) have known documented associations with 
psoriatic processes (2). Some other genes are also documented psoriasis markers 
(STAT1, SP1, AP1 proteins, and RAGE, which is a receptor that binds S100A9)(3-6), 
and many genes on this network serve as targets for known compounds (gray circles).  
The fact that these markers are up-regulated and all present on the same sub-network, 
which also happens to be one of the most significant here, corroborates the importance of 
these processes in psoriasis pathogenesis. This is a likely scenario in auto-immune 

1

2

3



 32

inflammatory disease that leads to proliferation of inflamed keratinocytes to the skin 
surface in a chaotic uncontrolled fashion, causing acute epidermal hyperplasia with the 
‘raw’ wound-like appearance, which eventually develops into scales, flaking off which in 
turn exposes yet another level on inflamed injured skin. 
 
Conclusions 
 
Two quick analysis steps in MetaCore™ (Enrichment Analysis Workflow and analyze 
network) led us to identification of key regulators of psoriasis-related processes. 
Enrichment analysis and network construction allowed us to evaluate statistically 
significant genes, which distinguish psoriatic samples from normal skin. In addition, 
examining the information extracted from the highest-ranked common processes in 
MetaCore™ has helped validate the implicated disease pathways, which recapitulate the 
inflammatory and proliferation/differentiation processes in psoriasis.  Upon further 
analysis, MetaCore may enable future identification of novel candidate gene leads that 
may serve as novel therapeutic intervention points or possible predictive markers of 
disease pathogenesis. 
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